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Abstract
Bradshaw, Larry; McCormick, Erin. 2000. FireFamily Plus user’s guide, version 2.0.

Gen. Tech. Rep. RMRS-GTR-67WWW. Ogden, UT: U.S. Department of Agriculture,
Forest Service, Rocky Mountain Research Station.

FireFamily Plus is the new software for summarizing and analyzing daily weather
observations and computing fire danger indexes based on the National Fire Danger
Rating System (NFDRS). While the software and packaging are new, many of the reports
are not. FireFamily Plus addressed the year 2000 issues that confronted a litany of DOS
programs that operated against fire weather files and combined the critical functionality
of many of those programs into one 32-bit Windows program.

FireFamily Plus philosophy departs significantly from the traditional way of process-
ing historical NFDRS indexes. Foremost, it has fire occurrence information integrated
throughout the program while historically programs have dealt exclusively with weather
only. This is accomplished through a fire weather/fire occurrence integrated database.
The database approach with computations “on the fly” allows a flexible analysis
environment, including station grouping, variable period groups (daily, weekly, and so
forth), and modification of station metadata.  FireFamily Plus will generate Pocket Cards
for Firefighter Safety and supports the climatological data requirements of Fire Behavior
Analysts making long-range fire growth assessments using Rerap and fire growth
projections using Farsite.

This user’s guide provides detail on obtaining historical fire weather and occurrence
data, importing those data into FireFamily Plus, and working with the analysis capabili-
ties of the program.

Keywords: Fire danger rating, fire weather, fire occurrence, fire danger climatology,
long range assessments, season ending events, diurnal fire weather, fire
business analysis
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Preface

Welcome to the FireFamily Plus User’s Guide.  This guide explains how to 
use the FireFamily Plus software application to perform fire danger analysis.

We hope you find this guide friendly and easy-to-use.  If you have any 
questions, comments, or concerns about this guide, please contact:

USDA Forest Service
National Fire and Aviation Management Information Systems Team
3833 S. Development Avenue
Boise, ID  83705

You can email us at:

fire_help@dms.nwcg.gov

To obtain a copy of the FireFamily Plus User’s Guide

1 Start your Internet browser.

2 In the address box, type http://www.fs.fed.us/fire/planning/nist, and 
then press ENTER.

3 Click Distribution, and then click FireFamily Plus User’s Guide.

What’s new
Version 2.0 is the first upgrade to version 1.2 that was released in May 1999.  
We've incorporated many of the suggestions from the extended beta test and 
done many things that allow the program flow better. Several screens have 
been modified for clarity and consistency. 

Specific areas that have changed include:

• Diurnal weather support, including export files for FARSITE. 

• Edit, print, export, and delete functions available when viewing weather 
and fire data.

• Better control of line characteristics on climatology overlay years graphs. 

• Graphs can be saved in JPEG, GIF, TIFF, or BMP formats. 

• The FIRES analysis has the goodness-of-fit statistics completed. 

• The decision point (DP) module from FIRES is complete. 

• Projections of NFDRS indexes can be generated in the Forecast module. 

• Import of USDI fire records can be filtered for the nine USDI fire types.

• A stand-alone NFDRS calculator has been added.

Windows 95, Windows 98, and Windows NT are registered trademarks of Microsoft Corporation.  This guide employs many styles, conventions, and guidelines 
established in “The Microsoft Manual of Style for Technical Publications.”
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Chapter 1.  About this guide

This guide explains how to use FireFamily Plus version 2.0.  It contains 
information about how to create a new database by importing station catalog 
and weather and fire data, how to define an active working set, how to 
generate reports and pocket cards, and how to perform fire analysis and 
forecasting functions.

Before you begin
Before using FireFamily Plus software, you must feel confident that:

• You are familiar with your personal computer and function keys and 
understand personal computer concepts.

• You are familiar with Windows 95, Windows 97, or Windows NT and can 
log on and log off.

• You have a basic understanding of fire weather observations, fire danger 
concepts, and terminology.

How to use this guide
You do not need to read this entire FireFamily Plus User's Guide to complete a 
specific task.  Once you understand how to start FireFamily Plus, you can 
quickly locate commonly used tasks by reviewing the “Contents” in the front 
of this guide.

This guide is divided into chapters.   The chapter title appears at the top of 
each page.  At the beginning of each chapter you will find an overview of the 
topics explained.  Where appropriate, diagrams are shown immediately 
following each task.

Chapter 1, “About this guide,” introduces the FireFamily Plus User’s Guide 
and explains how to use the guide.

Chapter 2, “Introducing FireFamily Plus,” explains Windows-based terms and 
concepts and how to install FireFamily Plus.

Chapter 3, “Working with FireFamily Plus,” explains how to create a database 
and define a working set, review weather data and generate reports, work with 
Season Reports, and use the Event Locator and the NFDRS Calculator.

Chapter 4, “Working with fire analysis tools,” explains how to use the fire 
analysis and decision point tools in FireFamily Plus to view and interpret 
combined weather and fire occurrence data.

Chapter 5, “Generating a pocket card,” explains how to generate a pocket card 
that identifies two years of interest for comparison.  It also includes 
instructions on changing the background pattern for your pocket card graphs.
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Chapter 6, “Working with fire danger projections,” explains how to generate 
medium range fire danger projections based on current year-to-date weather.  
It also outlines several techniques for developing fire weather scenarios.

Chapter 7, “Performing hourly data analysis,” explains how to work with 
hourly weather data.

The Glossary lists terms and definitions used in this guide.

References are arranged alphabetically and contain sources of information 
used to complete this guide.

Conventions
The following conventions are used within this guide:

• Option button labels and hard label keys appear in bold, in the same case 
as on your keyboard or screen.  For example, the second step in a 
procedure might instruct you to

2 On the Set Fire Associations dialog box, click the USFS tab.

• Topics of special interest or hints that will help you perform a specific 
task show a line before and after the text.  The text appears in italic type.  
For example

Although you can delete and then recreate a SIG, you cannot change its 
name once you save it.
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Chapter 2.  Introducing FireFamily Plus

This chapter explains the information you need to log on and use FireFam
Plus.  Topics include:

• Terms and concepts
• Installing FireFamily Plus.

Terms and concepts
This section identifies some of the screens, toolbars, and menus that you
be using in FireFamily Plus.  If you are not already familiar with Windows
based programs, become familiar with these terms and concepts before 
proceeding with the remaining chapters in this guide.

Screen terminology
The following diagram outlines many of the elements available on the 
Windows-based FireFamily Plus screen.

Screen elements and toolbars unique to a specific module are introduced 
within the corresponding chapter.
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n.
FireFamily Plus toolbar
The following diagram shows the expanded FireFamily Plus toolbar.  This
toolbar allows you to quickly access many FireFamily Plus functions by 
simply clicking a button.

Working set screen elements
The following diagram shows the new FireFamily Plus Working Set scree

The “Observation Type” group box, which allowed you to select either “Daily” 
or “Hourly” observation data, has been removed from this screen.
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Installing FireFamily Plus
This section outlines the basic instructions to install the FireFamily Plus 
program for Windows 95, Windows 98, and Windows NT operating 
environments.  The “FireFamily Plus Version 2.0 Release Notice” contain
the information and instructions you need to choose the correct self-extrac
install and/or upgrade setup program.

You can display the FireFamily Plus Version 2.0 Release Notice from the
Internet by entering the following address:

http://www.fs.fed.us/fire/planning/nist/distribu.htm

This release notice also identifies the system and data requirements, sample 
database, and uninstall instructions.  Review the entire notice carefully for 
complete instructions.

To download the FireFamily Plus installation file from the Internet

1 Start your Internet browser.

2 In the address box, type http://www.fs.fed.us/fire/planning/nist/
distribu.htm , and then press ENTER.

3 Scroll down to Release Notices, and then double-click FireFamily Plus 
Version 2.0 Release Notice.

4 Review the release notice to determine the appropriate installation file
you need to upgrade to FireFamily Plus version 2.0.

5 Double-click the appropriate installation file, and then save it in the fold
of your choice.

For a new installation, double-click ffp_20_setup.exe .  To upgrade from 
an older version of FireFamily Plus, double-click ffp_20_upgrade.exe .
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The following diagram shows the Fire Applications Support Distribution 
page.  The arrow points to the FireFamily Plus release notice.

To install FireFamily Plus

1 From your personal computer, double-click the self-extracting FireFamily 
Plus installation file.

2 Complete the installation process as instructed on your screen.

The following diagram shows the InstallShield dialog box.
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the 
The following diagram shows the Welcome dialog box.  Click Next to 
continue the installation process.

The following diagram shows the Start Copying Files dialog box.  Review 
Target Folder for the FireFamily Plus software, and then click Next to 
continue the installation process.
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his 
al 
The following diagram shows the Read Only File Detected dialog box.  T
displays when you already have FireFamily Plus installed on your person
computer.  To proceed, click Yes. 

To start FireFamily Plus

• On the Start menu, point to Programs, point to F&AM Applications , 
and then click Fire Family Plus.
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This chapter explains how to perform some common operations within 
FireFamily Plus.  Topics include:

• Opening the sample database
• Creating a database
• Defining an Active Working Set
• Reviewing weather data and generating reports
• Working with Season Reports
• Reviewing fire occurrence data
• Using the Event Locator
• Using the NFDRS Calculator.

Opening the sample database
FireFamily Plus is shipped with sample database “FFPLUS.mbd.” It contains 
station catalogs “101028” and “240107” and the Special Interest Group 
“Sample SIG.”

For more information about Special Interest Groups, see “Working with 
Special Interest Groups” later in this chapter.

To open the sample database

1 On the File menu, click Open.

2 Double-click FFPLUS.

The following diagram shows the sample database “FFPLUS” as it first 
appears on your screen.

For more information about the elements on this screen, see Chapter 2, 
“Introducing FireFamily Plus.”
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Creating a database
This section explains how to create a FireFamily Plus database that you will 
populate with station catalogs and imported historical and fire occurrence 
data.  Topics include:

• Retrieving and downloading data from KCFAST
• Importing your station catalog and weather data.

You can create as many databases as required to suit your needs. Although 
you can keep many databases open at the same time during your FireFamily 
Plus session, only one database is “active” at a time.

Retrieving and downloading data from KCFAST

To begin, you must access KCFAST from the Fire and Aviation Management 
web page. First, retrieve historical fire weather data, fire occurrence data, and 
the station catalog information.  Next, download the files from the ftp site to 
your personal computer.

For complete instructions about using KCFAST, see Appendix A, “Retrieving 
NIFMID data using KCFAST,” in the back of this guide.

To retrieve historical fire weather data

1 From the KCFAST Main Menu, click Weather.

2 Click Data Extract, and then click Historical.

3 Type the Station ID,  and then Begin and End Date Range.

4 Click Raw Datafile - 1972 Data Format.

To use diurnal functions or create files to support FARSITE, select Raw 
Datafile - 1972 Data Format, *.FW9.

5 Select the email notification option of your choice, click Submit, then 
write down the file name.

To retrieve U.S. Forest Service fire occurrence data

1 From the KCFAST Main Menu, click Fire.

2 Click Standard Extract.

3 Type the two digit Region and two digit Forest numbers.

4 Type the Begin Year and End Year Date Range.

5 Click NFMAS - PCHA (PC Historical Analysis).

6 Click Raw Datafile.

7 Select the email notification option of your choice, click Submit, then 
write down the file name.
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To retrieve station catalog information for a single station

1 From the KCFAST Main Menu, click Weather.

2 Click Station Catalog, and then click Station Information.

3 Click BY SINGLE STATION, and then type the desired Station ID.

4 Click Send file to FTP site.

5 Select the email notification option of your choice, click Submit, then 
write down the file name.

To download a file from ftp.fs.fed.us

1 Start your Internet browser. 

2 In the address box, type ftp://ftp.fs.fed.us/incoming/wo_fam then press 
ENTER.

3 Right-click the file name of your choice, click Copy to folder, then 
double-click the folder of your choice.

Importing your station catalog and weather data

After saving the historical fire weather data, fire occurrence data, and the 
station catalog information on your personal computer, you can import the 
information into the newly created database.

To create and save a new database

1 On the File menu, click New.

2 In the File name box, type the name of your new database, and then click 
Save.

The following diagram shows the “New FireFamily Plus Database” 
dialog box.
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To import a station catalog

1 On the Data menu, click Import.

2 Click WIMS Station Catalogs, and then double-click the desired station 
catalog file.

3 When finished click Close, and then click Close on the Import Fire and 
Weather Data dialog box.

4 To review the station catalog, click Stations on the Data menu, click the 
desired station ID, and then click Edit.

The following diagram shows the Import Fire and Weather Data dialog 
box.

The following diagram shows the Import Complete dialog box.

To review, print, and/or save the error log, click View Log.
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The following Weather Stations dialog box lists all the station catalogs 
available in your working set database.

The following Edit Station Information screen shows station catalog 
“050505.”

To import historical fire weather data - optional

1 On the Data menu, click Import.

2 Click Old Fwx Fires, and then double-click the desired historical fire 
weather data file.

To import historical fire weather data retrieved in the 1998 data format, 
click New FW9 Files.
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To import FS fire occurrence data

1 In the Agency box, type or select USFS.

2 Click RAW Files, and then double-click the desired fire occurrence file.

3 When finished click OK, and then click Close.

Since FS fire occurrence data is verified for duplicate records, this import 
process may require several minutes.  For datasets containing more than 
10,000 records, this process may require several hours!

To compact the database

1 On the Data menu, click Compact.

2 Select the Duplicate Weather Records option of your choice, and then 
click OK.

The following diagram shows the Compact Database dialog box.  From here, 
you can remove extra storage due to records that you deleted from your 
database, or check for duplicate records.

Defining an active working set
This section explains how to define an active working set and how to set fire 
associations.  Think of the “working set” as a filter of the active database.  By 
filtering the database, you can use the data that pertains only to your specific 
fire danger analysis needs.  For example, you may choose to analyze the 
potential for the fall fire season or determine the window for the spring 
prescribed fire season.

Setting fire associations allows you to define which fires are associated with 
the weather station or stations in the working set.  You can also blend fires 
from different agencies.

Every output of FireFamily Plus directly relates to the configuration of the 
working set.  Therefore, be sure that each of the eight elements in the working 
set accurately reflects your data requirements.
July 1, 2000 3.6



Chapter 3. Working with FireFamily Plus FireFamily Plus User’s Guide
To define the Active Working Set

1 On the SIG/Station box, select the desired station ID.

2 Change the remaining Active Working Set Definition fields as needed.

The following diagram shows a sample Active Working Set Definition for 
station “050505.”

To set fire associations

1 Click Fire Associations.

2 On the Set Fire Associations dialog box, click the USFS tab.

3 Select the Region(s), Unit(s), and Sub Unit(s) of your choice.

4 To verify your selections, click View Selections, then click OK.

5 To review fire data, click View Fires.

The following “Set Fire Associations for 050505” dialog box shows 
Region 02 and Unit 10 selected.
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The following “Edit Fire Occurrence Data” screen lists all fires for station 
“050505” and based on the Active Working Set.

Working with Special Interest Groups

A Special Interest Group (SIG) is a collection of weather station catalogs that 
you group together to analyze fire danger climatology.  You can group as 
many stations as you wish, then weigh the importance of each station within 
the SIG.  In this way, you can adjust the influence of each station when 
performing FireFamily Plus calculations.

FireFamily Plus creates new pseudo weather records for each day using all 
available data from every station in the SIG.  If any station within the SIG has 
a data record for a day, the SIG will have a weather record for that day.  If no 
stations have a data record for a particular day, the SIG will not have a 
weather record for that day.

To create a Special Interest Group

1 On the Data menu, click SIGS, and then click New.

2 In the SIG Name box, type a meaningful name for the SIG.

Although you can delete and recreate a SIG, once you save it you cannot 
change its name.
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3 In the Description box, type a description that identifies the SIG and its 
purpose.

4 Under Available Stations, select the station of your choice, then click 
>>>> to include that station in the SIG.

5 When finished adding stations to the SIG, click OK.

The following diagram shows the Special Interest Groups dialog box.

The following diagram shows the Enter Special Interest Group Attributes 
dialog box.  From here, you can include or remove station catalogs in the SIG 
that have been imported into your database. 

Only station catalogs imported into the database will display on this dialog 
box.  To import additional station catalogs, see “Importing your station catalog 
and weather data,” earlier in this chapter.
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The following diagram shows the new SIG as it appears on the Special 
Interest Groups dialog box. 

To set weights to stations in a SIG

Weight factors are relative in FireFamily Plus.  Initially, every station in the 
SIG is assigned a weight factor of “1.0,” denoting equal weight for all stations.  
To increase a station’s importance for your analysis, simply increase its 
weight. For example, to double the importance of a particular station, enter 
“2.0” as its weight.  To reduce the importance of a particular station by half, 
enter “0.5” as its weight.

1 From the Special Interest Groups dialog box, select the SIG Name of 
your choice, and then click Set Weights.

2 For each station, type the appropriate weight, and then click OK when 
finished.

The following diagram shows the Set Station Weights dialog box.
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To save a Special Interest Group

• When finished adding stations and setting weights to each station to the 
SIG, click Close.

To edit a Special Interest Group

1 On the Data menu, click SIGS.

2 From the Special Interest Groups dialog box, select the SIG Name of 
your choice, and then click Edit.

3 Add and remove the station(s) of your choice, then click OK when 
finished.

4 Click  Set Weights, type the appropriate weights for each station, then 
click OK.

5 To save your changes and exit, click Close.

To delete a SIG from the database

1 On the Data menu, click SIGS.

2 From the Special Interest Groups dialog box, select the SIG Name of 
your choice, and then click Delete.

3 Click Yes to confirm or No to cancel, then click Close.

The following diagram shows the delete confirmation dialog box.
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Reviewing weather data and generating reports
This section explains how to review weather data and generate Climatology 
statistical tables and graphs. 

To review weather observations

• On the Weather menu, point to View Observations, and then click All.

The following “View Weather Data” screen lists the weather observations 
for station “050505.” 

To sort by any field, right-click on the column heading of your choice.  To 
adjust column width, drag the column heading to the desired width.  

To remove duplicate records

1 On the Data menu, click Compact.

2 Click Remove Duplicates, and then click OK.
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The following diagram shows the Compact Database dialog box.

To review weather data by generating a statistical table

1 On the Weather menu, click Climatology. 

2 Select the Stats Table check boxes of your choice, and then click Run.

The following “Climatology Options” dialog box shows the statistical 
table, “Burning Index” selected.

The CP #1 and CP #2 columns identify the critical percentiles that are used 
when you generate statistical tables. 

CP #1 and CP #2 are also used when generating percentile graphs, daily 
frequencies, and pocket cards.
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The following screen shows the statistical table for Burning Index for 
station “050505.”  As shown in the previous diagram, the 90th critical 
percentile was used for this statistical table.

Only data defined by the active working set is included in the table.

To review weather data by generating statistical graphs

1 On the Weather menu, click Climatology. 

2 Select the Stats Graph check boxes of your choice, and then click Run.

Clear any check boxes in the Stats Table column.

The following diagram shows a three-day Analysis Period Length (Days). 
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The following “Climatology Options” dialog box shows Energy Release 
Component and Burning Index variables selected.  The critical percentile 
values for both the Energy Release Component and Burning Index are set to 
“90” for CP#1 and “97” for CP#2.

The following diagram shows the Burning Index statistics graph and 
weather percentile graph.   
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The following diagram shows the Energy Release Component statistics graph 
and weather percentile graph.
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To resize a statistical graph

• To maximize the statistical graph of your choice, double-click anywhere 
on that graph.

The following diagram outlines how to adjust the size of the statistical graphs.  
You can click and hold the bar that separates the two statistical graphs, then 
slide the bar right or left to obtain the desired size.
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To determine a specific value on a statistical graph

• Click the point of your choice.

The following diagram shows the X value and Y values of a particular point 
on a statistical graph.

Working with overlays

After you create a statistical table or graph, you can add an overlay to 
highlight specific years of interest.

To create an overlay on a statistical graph of your choice

1 On the Options menu, click Overlays.

2 Click New, then select the Year, Line Style, and Color for the overlay.

3 To review the appearance of the overlay, click Apply.

4 When finished adding new overlays, click OK.
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The following diagram shows 1977 and 1978 defined as overlays.

You can adjust the Color, Width, and Line Style to enhance the appearance of 
your statistical graphs.

The following diagram shows the Burning Index statistics graph and weather 
percentile graph.  Note the added overlays for the 1977 and 1978.
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The following diagram shows the Burning Index statistics graph and 
weather percentile graph with added overlays for 1977 and 1978.

Changing the look of your statistical graphs

Graph Options on the Options menu displays a dialog box that allows you to 
modify the appearance of your statistical graphs.

The Graph Display Options contains the following tabs:

• The General tab allows you to change the grid line style, the type of 
graph you create, and the line colors for the Overall Percentiles, “CP 1” 
and “CP 2.”

• The Bar Graph tab allows you to choose Range tics and/or Critical 
Percentile tics for your statistical bar graph.

• The Line At Average tab allows you to change the color and width of the 
Average, Minimum, Maximum, CP 1, and CP 2 lines.  You can also clear 
the Minimum, Maximum, CP 1, and CP 2 check boxes to eliminate those 
lines from your statistical graphs.

• The Fires tab allows you to highlight the Fire Days, Large Fire Days, and 
Multi Fire Days, select which fire cause to display, and specify the 
number of acres for Large Fires and the number of Fires for a Multi Fire 
Day.

• The Fire Danger Projections tab allows you to modify the line color, 
width, and style of your fire danger projection.
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The following diagram shows the settings available on the General tab.

The CP 1 and CP 2 check boxes allow you to graph the critical percentile 
values that are defined on the “Climatology Options” dialog box.  For more 
information, see the second diagram in “To review weather and fire data by 
generating statistical graphs,” earlier in this chapter.

The following diagram shows the settings available on the Bar Graph tab.

The following diagram shows the settings available on the Line Average tab.
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The following diagram shows the settings available on the Fires tab.

The following diagram shows the settings available on the Fire Danger 
Projections tab.

For more information about the changing the graph options on this tab, see 
Chapter 6, “Working with fire danger projections” later in this guide.

To change the look of your statistical graphs

1 On the Options menu, click Graph Options, click the tab of your choice, 
and then change the settings as desired.

2 Click Set as Default to change your default settings, click Apply to 
change the settings to the current graph, click Apply To All to change the 
settings of all open graphs, or click Close to cancel.
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To create a statistical bar graph

1 On the Options menu, click Graph Options.

2 Click Statistical Bars, select the colors for CP 1 and CP 2 of your 
choice, and then click Apply. 

The following diagram shows the Graph Display Options dialog box to create 
a statistical bar graph. 

The following diagram shows the resulting statistical bar graph.

To generate a wind report by month

1 Change the Analysis Period Length (Days) to 28.

2 On the Weather menu, click Winds. 
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The following “Wind Speed vs. Wind Direction” report shows the 
prevailing wind speed range and direction for May.  Use the scroll bar to 
review other months.

About the Enable Auxiliary Year Overlay check box

The Enable Auxiliary Year Overlay check box allows you to overlay years of 
data outside the Data Years.  The following diagram shows the location of the 
Enable Auxiliary Year Overlays check box.  

You must select the Enable Auxiliary Year Overlays check box on the Active 
Working Set screen before you can create an overlay from a data year that is 
outside the working set.
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Working with Season Reports
Season Reports summarize the seasonal variations of fuel moistures, NFDRS 
indices, and components.  You can generate the following reports:

• Persistence Probability, which reports the chance that tomorrow’s 
variable will be the same as today’s.  The higher the persistence, the less 
likely the weather will change.

• Severity List, which ranks each year at a fire weather station in terms of 
the burning index.  The ranking accounts for how often and how much 
each day’s Burning Index exceeds the 90th critical percentile.

• Severity Summary, which summarizes the Severity List.

• Probability Analysis, which shows how often you can expect values of 
your adjective class to occur, and provides detailed information that you 
need to perform fire management activities.

• Daily Listing, which identifies historical weather records that you can 
compare against your original weather records.

To generate a Persistence Probability report

1 On the Weather menu, click Season Reports, and then click Persistence 
Probability.

2 In the Index list, select the variable of your choice.

3 Type the Display Ranges values, and then click OK.

The following diagram shows the Generate Persistence Probabilities 
dialog box for precipitation amount.
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The resulting Persistence Probabilities report shows the probability and 
amount of precipitation to expect.

To generate a Severity List

1 On the Weather menu, click Season Reports, and then click Severity 
List.

2 In the Index list, select the variable of your choice.

3 Type the Critical Percentile value, select the appropriate Display 
Values, and then click OK.

The following diagram shows the Generate Seasonal Severity List dialog 
box for Wind Speed above the 97th percentile.
July 1, 2000 3.26



Chapter 3. Working with FireFamily Plus FireFamily Plus User’s Guide
The resulting Severity List report shows the number of years that had high 
winds during peak fire months.

To generate a Severity Summary

1 On the Weather menu, click Season Reports, and then click Severity 
Summary.

2 In the Index list, select the variable of your choice.

3 Type the Critical Percentile value, select the appropriate Display 
Values, and then click OK.

The following diagram shows the Generate Seasonal Severity Summary 
dialog box for 1000-hour Fuel Moisture for days below the critical 
percentile of “3,” the driest days.
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The resulting Severity Summary report measures the number of days with 
large fuels below the critical percentile of “3.”

To generate a Probability Analysis

1 On the Weather menu, click Season Reports, and then click Probability 
Analysis.

2 In the Index 1 list, select the variable of your choice. 

3 In the Index 2 list, select the variable of your choice. 

4 Type the Index 1 Display Ranges, type the Index 2 Display Ranges, and 
then click OK.

The following diagram shows the Generate a Probability Analysis Report 
dialog box that determines the likelihood of a value of Energy Release 
Component given the value of Spread Component.
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The resulting Probability Analysis report shows the probability of a high 
Spread Component value given a high Energy Release Component.

To generate a Daily Listing

1 On the Weather menu, click Season Reports, and then click Daily 
Listing.

2 Select the General, Data Format, and Time Format of your choice.

3 On the Available Variables list, highlight the variables of your choice, 
and then click >>>>.

4 When finished adding variables to the Selected Variables list, click OK.
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The following diagram shows the selected variables for the Daily Listing.

The resulting Daily List shows the recorded/calculated values for the working 
set observations for Precipitation Amount, Spread Component, Energy 
Release Component, and Burning Index.

You can save this as a .txt file and import it into spreadsheet and/or graphics 
software applications.
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Reviewing fire occurrence data
This section explains how to generate a summary graph of fire occurrence 
data.  You can either generate a general summary graph of all imported fire 
occurrence data, or generate a working set summary graph of the fire 
occurrence data that is contained in your working set.

To review fire occurrence data by generating summary graphs

In this example, you will generate summary graphs from fire occurrence data 
not associated with the working set for years 1988 through 2000.

1 On the Fires menu, point to Summary and then click General.

2 Click the USFS tab, and then select the Region(s), Unit(s), and Sub 
Unit(s) of your choice.

3 Click the Years tab, then type the Start Year and End Year of your 
choice.

4 The review the fire occurrence data, click View Fires.

5 To generate the Fires Summary graphs, click OK.

The following diagram shows the USFS tab of the Select Fires and Years for 
General Summary dialog box.
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The following diagram shows the Years tab of the Select Fires and Years for 
General Summary dialog box.

The following diagram shows the fire occurrence data for 1988 through 2000.

To sort by any field, right-click on the column heading of your choice.  To 
adjust column width, drag the column heading to the desired width.  
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The following diagram shows the frequency distributions of Fire and Acres 
by year, Fires by month, Fires by Size Class, Fires by Cause Class, and 
number of Fires per Fire-Day for the Arapaho & Roosevelt National Forests.

To review the working set fire occurrence data by generating 
summary graphs

In this example, you will review only fire occurrence data associated with your 
working set.

1 On the FireFamily Plus toolbar, click Fire Summary Working Set.

2 Click the USFS tab, and then select the Region(s), Unit(s), and Sub 
Unit(s) of your choice.

3 Click the Years tab, then type the Start Year and End Year of your 
choice.

4 The review the fire occurrence data, click View Fires.

5 To generate the Fires Summary graphs, click OK.
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The following diagram shows the working set frequency distributions of Fire 
and Acres by year, Fires by month, Fires by Size Class, Fires by Cause Class, 
and number of Fires per Fire-Day.

Use the Size Class and Fires/Fire-Day graphs to determine large fire-days 
and multiple-fire days, which relate fire business to indexes.
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Using the Event Locator
The Event Locator allows you to locate, count, and list dates of specified 
weather events that occur on a single day or over consecutive strings of days.  
As a fire manager, and with the help of local expertise, you must decide what 
kind of weather will stop fire spread.

An event is a single or combination of weather and NFDRS parameters that 
meet your specified conditions.  You can define these conditions as those that 
occur on a single day, or that occur over a string of consecutive days.

For example, the Event Locator allows you to:

• determine dry spells, such as periods of time when there was no rainfall

• inspect the database for suspect data, such as listing the days when the 
wind exceeded 50 miles per hour

• list five-day periods where .2 inches or more of rain fell, thus causing a 
fire-ending event.

The Event Locator allows you to use the following categories to identify 
particular values:

• Avg.  The average of the variable for the period.
• Sum.  The summed, or total, of the variable.
• Min.  The minimum value in the string.
• Max.  The maximum value in the string.
• Daily.  The daily value in the string.

To search for erroneous data - an example

This example explains how to search for precipitation amounts greater than or 
equal to 5 inches per day.

1 On the File menu, click Open, and then select the Active Working Set 
Definition of your choice.

2 On the Weather menu, click Event Locator.

3 In the Period Length (Days) box, type 1 and then press TAB twice.

4 In the Variable box, select Precipitation Amount, and then press TAB.
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5 In the Category box,  select Min, and then press TAB.

6 In the Operator box, select >=, and then press TAB.

7 In the Value box, type 5.0 and then press TAB.

8 In the Value Type box, select Value, and then click OK.

The following diagram shows the Event Locator dialog box for searching for 
daily  precipitation amounts greater than 5 inches.

The following diagram shows the resulting FireFamily Plus Event Locator 
Report Listing of Selected Events for weather station “050505.”

To search for a fire-ending event - an example

This example explains how to search for five-day periods with precipitation 
amounts greater or equal to .2 inches.  The fire is assumed to start on August 
5th on the Arapaho & Roosevelt National Forest, in an area that is well 
represented by the Redfeather weather station, “050505.”

1 On the File menu, click Open, and then select the Active Working Set 
Definition of your choice.

2 In the beginning Month and Day boxes, select August 6.

3 On the Weather menu, click Event Locator.
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4 In the Period Length (Days) box, type 5 and then press TAB twice.

5 In the Variable box, select Precipitation Amount, and then press TAB.

6 In the Category box,  select Sum, and then press TAB.

7 In the Operator box, select >=, and then press TAB.

8 In the Value box, type .20 and then press TAB.

9 In the Value Type box, select Value, and then click OK.

The following diagram shows the Event Locator dialog box for determining 
five-day periods of precipitation amounts greater or equal to .2 inches.

The following diagram shows the resulting Event Locator Report 

The rain may have fallen all on the first day, all on the last day, or somewhere 
in between.  Note that several season-ending events have occurred within a 
single year.
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Be certain of your active working set.  If it defines only a subset of your data, 
the computed percentile may not reflect what you really want.  

To use the Event Locator on a data subset and a percentile-related value as 
your threshold criteria, generate a statistical table to determine that threshold, 
then enter it in the Value box in the Event Locator dialog box.  For more 
information, see “Reviewing weather data and generating reports,” earlier in 
this chapter.

To perform a more complex query - an example

In this example, you will add ERC as a variable to check the season ending 
date, given the maximum ERC during that five-day period with rain remains 
below the 67th percentile.

For the Redfeather weather station, the 90th percentile for ERC in fuel model 
G is about 59.  Looking at fire business, fire activity appears to accumulate at 
or above an ERC of about 44, or roughly at the 67th percentile.

1 On the Weather menu, click Event Locator.

2 In the Period Length (Days) box, type 5 and then press TAB.

3 Press ↓ (down arrow) to add a new line.

To add a new row, press ↓ (down arrow) or INSERT.  To delete a row, press 
DELETE.

4 Click the Operator arrow, select AND, and then press TAB.

5 In the Variable box, select Energy Release Component, and then press 
TAB.

6 In the Category box,  select Max, and then press TAB.

7 In the Operator box, select <, and then press TAB.

8 In the Value box, type 44 and then press TAB.

9 In the Value Type box, select Value, and then click OK.

The following diagram shows the completed Event Locator dialog box that 
allows you to determine 5-day periods when ERC is no more than 44 and 
precipitation is .2 inches or more. 
July 1, 2000 3.38



Chapter 3. Working with FireFamily Plus FireFamily Plus User’s Guide
The following diagram shows the resulting Event Locator Report Listing of 
Selected Events for weather station “050505.”  Notice that this combination 
extends some of the season ending dates further into autumn. In 1982 and 
1985 there are no season ending dates.

If you are unsure whether the date represents the end of season or which 
date to use, generate an ERC graph and create an overlay of the year of your 
choice.  If the ERC remains low, you have found the season ending date.

For more information about determining the ERC and weather percentile for 
the previous example, see Chapter 4, “Working with fire analysis tools,” later 
in this guide.
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Using the NFDRS Calculator
The NFDRS calculator is a tool that allows you to calculate NFDRS indexes 
based on the information you enter.  Although you must have FireFamily Plus 
version 2.0 installed on your personal computer, you can use the NFDRS 
calculator by itself or in conjunction with other fire analysis software 
applications.  The NFDRS calculator allows you to:

• perform NFDRS sensitivity analysis

• compare outputs between fuel models, such as comparing fuel model “A” 
against “B” or ‘78 against ‘88

• calculate KBDI

• review and compare parameters among fuel models.

To use the NFDRS calculator

1 Click NFDRS Calculator on the FireFamily Plus toolbar.

You can also click NFDRS Calculator on the Weather menu.

2 Select the Fuel Model and Slope Class of your choice.

3 Select the Use 88 Model check box if appropriate.

4 Type the Temperature, 20’ Wind and SOW text boxes as appropriate.

Remember that Temperature and SOW (State of the Weather) affect 
Ignition Component, while 20’ Wind affects Spread Component and 
Burning Index.

5 Complete the Fuel Moistures  text boxes as appropriate for the selected 
fuel model.

Moisture classes that are unavailable for the selected fuel model appear 
dimmed.

6 Complete the 88 Model Inputs if appropriate.

7 Click Calculate.

The following diagram shows the NFDRS Calculator.
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To calculate the Keetch-Byram Drought Index for 88 Models

• Click KBDI calculator.

The following diagram shows the KBDI Calculator as it first appears on your 
screen.

To compare parameters among fuel models

1 Click Fuel Model Parameters.

2 Select the Fuel Model of your choice, click Use 88 Model if appropriate, 
and then click Add To Table.

3 Add additional Fuel Model(s) of your choice, then click Add To Table.

To delete a Fuel Model from the table, click the row of your choice, and 
then press DELETE.

The following diagram shows the View NFDRS Fuel Model Parameters table.

The following units are standard:  

• loads are measured in T/Ac
• surface area to volume ratios are measured in 1/ft
• heat content is measured in btu/lb
• depth is measured in feet
• moisture of extinction is measured in percent.
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Chapter 4.  Working with fire analysis tools

This chapter explains how to view and interpret combined weather and fi
occurrence data using the fire analysis and decision point tools of FireFa
Plus. These tools help you perform a variety of fire analysis functions, 
including:

• Interpret danger indexes. You can relate danger indexes to fire activit
based on a percentage or probability basis.

• Choose appropriate fuel model and index.  FireFamily Plus tools offer
objective way to evaluate the many indexes and fuel models.

• Evaluate representative weather stations. By comparing fire activity in
management area to indexes that are based on weather data from se
area stations, you can determine which stations are most representat
fire business.

• Set better decision thresholds.  Historically, critical levels for an index
have been defined from percentile levels without regard to fire activity.  
By integrating weather and fire activity, you can better determine 
percentile levels to suit a variety of fire management needs.

Topics in this chapter include:

• Performing cumulative and probability fire analysis
• Setting decision points.

The following diagram shows the active working set used for the example
this chapter.
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Performing cumulative and probability fire analysis
This section explains how to generate graphs using ERC, which reflects 
good fire business indicator for the sample data set.  Due to the speed and
of generating graphs, use several fuel models and indexes when perform
fire analysis on your own databases.

The Cumulative Fires Analysis window displays frequency distributions of 
four groups of weather days in two ways.  The left panel shows frequencie
histograms, while the right panel shows cumulative distributions.  The 
following four weather groups are identified in these graphs:

• all weather days regardless of fire activity - black 
• only weather days with a reported fire - blue
• only weather days with large fires - purple
• only weather days with multiple fires - red.

Once you get the feel for what you are looking for, you may find that the best 
way to “screen” indexes is to perform the Cumulative Analysis first, and then 
perform the Probability Analysis on your best indexes.

To review the Working Set for FS fire occurrence data

1 On the FireFamily Plus toolbar, click Fire Summary Working Set.

2 To verify that only the desired fire associations are selected, click View 
Selections.

3 To review the fire occurrence data, click View Fires.

4 To review the fire occurrence summary graphs, click OK .

The following diagram shows the selections for the Redfeather weather 
station.
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The following diagram shows the Fire Summary for the Redfeather weath
station.  The Size Class graph located on the lower left allows you to 
determine what constitutes a larger fire in this analysis area.  The Fires/F-
graph located on the lower right allows you to determine the number of fi
per fire-day that tax the suppression resources. Here, a Class C or larger fire
defines a large fire-day and 5 fires per day defines the threshold for a mul
fire-day. 

Your weather and fire occurrence data may or may not provide the same 
levels of success.  For a brief narrative of this Fire Summary, see “To review 
the working set fire occurrence data by generating summary graphs,” in 
Chapter 3, “Working with FireFamily Plus.”

To narrow or exclude FS fire occurrence data for your analysis

• Change the Data Years fields of your working set to match the desired 
years of fire data coverage.  

To perform Cumulative and Probability fire analysis using ERC

1 On the FireFamily Plus toolbar, click Fire Analysis.

2 Select the appropriate Fire Cause and Analysis Type option buttons.

3 Complete the Fire Definitions fields.

Use your local experience and/or results from your fire occurrence graph.

4 In the Analysis Variable list, select Energy Release Component, and 
then click OK .
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The following example shows the Set Fire Analysis Options dialog bo

Evaluating Cumulative Fires Analysis graphs
Use the following principles to evaluate the frequency distributions of the
four groups of weather days:

• When lines are horizontal, there are no weather days happening in th
ERC range.

• When lines approach vertical, there are many days in that ERC group

• If lines are drawn on top of each other, which denotes no difference in the 
four weather distributions, the particular index you are using contains
relevant information about fire business.  

• If the lines are nicely spread out, which denotes a difference in the 
weather distributions, the fires and large fires occur on higher “dange
days.
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The following diagram shows the Cumulative Fires Analysis graphs fo
ERC.

The left panel shows you that fire-days tend to occur on higher ERC days
multiple fire-days begin to occur when ERC is around 44.

The right panel shows that fire-days (blue line) start occurring slowly at E
values from 8 to 22.  The rate of occurrence picks up between 22 and ab
34.  Above 34 to just over 55, they occur at a steady rate.

Large fire-days are shown by the purple line.  There were no large fires w
the ERC was below 22 or 23.  This is where the purple line comes off of t
ERC X-axis.  Large fire-days occur at a fairly steady rate from ERC value
about 45 or so.  The point where ERC equals about 45, where the large f
day line changes slope (the slope becomes steeper), is an important poin
this graph, especially since the slopes of the all-day and fire-day lines do not 
change slopes through this point.  You can interpret that while the rate of
days was consistent through ERC of 45, the rate of large fire-days increa
above that threshold level.

Multiple fire-days is shown by the red line.  The jerkiness of this line indica
there were only a few multiple fire-days at our defined threshold of 5 fires 
day.  An ERC of 40 was the minimum ERC that a multiple fire-day occurred.  
From ERC of 40 to 60, there were probably 2 multiple fire-days, one at 52 
one and 53 or 54, and then the rest occurred at ERC values between 63 a
or so (where the line goes nearly vertical).
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To determine the percentile value, you can cross-reference any of these 
threshold points we’ve identified to the percentile axis.  An ERC of 50, for 
example, represents about the 75th percentile of all days, but only the 35
percentile of large fire-days.

Evaluating Fires Probability Analysis graphs
Based on your fire associations, Fires Probability Analysis takes every 
historical weather day, including date and index value, and assigns each 
as a:

• fire-day (yes/no)
• large fire-day (yes/no)
• multiple fire-day (yes/no).

Logistic regression is performed for each fire-day type, producing charts 
goodness of fit statistics.

Logistic regression is ideal for “yes/no” types of data.

The following diagram shows the Fires Probability Analysis graphs for ER
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When you review the Cumulative Fires Analysis graphs, remember that f
days started picking up above an ERC value of 22.  The logistic model 
reinforces this interpretation.

The final goal here is to discern a good index from a bad one in terms of its 
ability to describe fire business.  To do this, we look at two qualities:

• Range of probabilities over the range of the predictor variable

- 10 percent at the low end to 90 percent on the high end is very go
- 10 percent at the low end to 15 percent on the high end doesn’t te

much.

• Distribution of predictor variables

- A wider range (0 - 100) allows more flexibility in setting levels.
- A narrow range (12 - 22) may make setting levels harder.
- Avoid 90 percent of observations in one/two classes.

When you’ve screened out all the bad indexes, use goodness-of-fit statistics t
determine your best index.  

There are two statistics to test goodness-of-fit:

• Chi Square, where a lower value is better
• R-Squared, where a higher value is better.

For a complete discussion of the analysis of indexes, refer to:

Andrews, Patricia L. and Larry S. Bradshaw. “FIRES:  Fire Information 
Retrieval and Evaluation System - a Program for Fire Danger Rating Analysis” 
at

http://www.fs.fed.us/rm/pubs/int_gtr367/index.html .
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Setting decision points
This section explains how to set action or danger class limits based on bo
fire weather and fire business in the your danger rating area. Before you 
begin, be sure that your working set is correctly configured, including yea
dates, and fire associations. 

The Decision Points button on the FireFamily Plus toolbar is only available 
when displaying a Fires Probability Analysis graph.

The Set Class Lower Limits dialog box displays the initial breakpoints tha
divide the data into five classes.  These initial breakpoints are set using 
roughly the same logic as setting the Adjective Classes in WIMS.

To set decision points

1 On the Fires menu, click Fire Analysis.

2 To generate the Fires Probability Analysis graphs, click Probability 
Analysis, select the Analysis Variable of your choice, and then click 
OK .

3 Click Decision Points.

Class Lower limit

1 Zero

2 ¼ of the index’s 90th percentile value

3 ½ of the index’s 90th percentile value

4 The index’s 90th percentile value

5 The index’s 97th percentile value
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The following diagram shows the Set Fire Analysis Options dialog box.  
Energy Release Component is selected as the Analysis Variable.

The following diagram shows the Fire Probability Analysis graph. 
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The following diagram shows the Set Class Lower Limits dialog box and 
initial breakpoint values for each class.

The following diagram shows the Decision Points graphs for ERC.  To 
expand the graph of your choice, click, hold, and slide the bars according
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Reviewing the Decision Points graphs
The following diagram shows the Percentile and Probability graphs for ER
that are located on the lower left portion of the Decision Points window.  T
vertical lines show you where the class boundaries fall along the curves.

The following diagram shows the Decision Points table that is located on
upper left portion of the Decision Points window. You can modify this tabl
and the Percentile and Probability graphs by applying new decision point
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The following diagram shows the Classes and Percent Days Based on E
bar chart that is located on the lower right portion of the Decision Points 
window.  The chart shows the relative frequency of the four weather type
days:  All Days, Fire-Days, Large Fire-Days, and Multi Fire-Days.  The ba
chart on the top shows all day-types combined.

When reviewing the Decision Points graphs, consider the following:

• Differentiate each class from the class above or below it for different fire 
business.

• Ensure that each class has a significant increase of risk, perhaps even 
twice the risk.

• Obtain the minimum number of classes you need to support decisions 
and actions.
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Changing decision points to reflect fire business
Now that you have reviewed the Decision Points graphs, you can change
values in the Set Class Lower Limits dialog box to adequately reflect fire 
business.  The following list outlines how your bar charts should look like a
why:

• As fire danger moves from Class 1 to Class 5, you should see a stead
increase in the risk of large and multiple fire days.

• As fire danger moves from Class 1 to Class 5, the ratio of days to larg
fire days should decrease.

• As fire danger moves from Class 3 to Class 4 and to Class 5, the 
percentage of large fire days and multiple fire days should not decline
Ideally, these fire days would increase.

The following diagram shows dotted lines above each bar chart to 
demonstrate the ideal trends.  

By comparing the dotted lines to each bar chart, you know that:

• The proportion of fire days in Class 3, at over 70 percent, is too high.

• The Large Fire-Days and Multi Fire-Days bar charts do not show an 
upward trend from low to high.

To determine how to change these class limits, you must review the 
Probability vs. ERC graph.
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The following diagram shows the Probability vs. ERC graph.  The arrow 
points to where the Fire Day curve begins to rise more steeply, indicating
the probability of a fire occurring increases faster as ERC rises.  This is a 
choice for changing the Class 3 lower limit. 

Notice that the Large Fire and Multi Fire curves just begin to show an upward 
trend.  You may decide to include more Large Fire-Days and Multi Fire-Days 
in Classes 4 and 5.
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To change the Class lower limits

• On the Set Class Lower Limits dialog box, type or select the Value for 
each Class, and then click Apply.

The following diagram shows the new values for the Set Class Lower Lim
dialog box.  To reduce the lower limits, or decision points, the value of Cla
was changed to “31,” the value of Class 4 was changed to “48,” and the v
of Class 5 was changed to “56.” 

The following diagram shows the new Classes and Percent Days Based 
ERC bar charts.  Notice that these new bar charts have a more reasonab
distribution of Fire-Days, Large Fire-Days, and Multi Fire-Days.

You can apply some other class values and review the changes in the bar 
charts.  Add or delete classes using the New and Delete buttons on the Set 
Class Lower Limits dialog box.  You can perform some interesting analysis 
using only two classes.  Return to the section, “Performing cumulative and 
probability fire analysis,” choose other analysis variables, and then perform 
additional analysis.
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Chapter 5.  Generating a pocket card

A pocket card is a safety tool that identifies key information about a spec
fire danger area.  And with Fire Family Plus, you can generate a pocket c
at any time to increase firefighter awareness of the current local conditions. 

Identifying the years of interest, fires, and index values
Use the climatology reports and fires analysis information generated in 
Chapter 3, “Working with FireFamily Plus,” to determine and define which
two years of interest, indices, and thresholds you need to create a meani
pocket card.

Based on prior examination of seasonal trends of various indexes and fir
analysis, use the following information for the pocket card:

• ERC is selected as the NFDRS index value.

• Fuel model G is the primary fuel model for the Redfeather weather 
station.

BI is often used for staffing.

To determine the years of interest for comparison

1 Start FireFamily Plus.

2 On the File menu, click Open, then double-click ARF.mbd.

3 Edit the Data Years to include all available years of data, 1975 through 
1998.

4 Edit the Annual Filter  to include the entire fire season, May 1 through 
October 31.

5 On the FireFamily Plus toolbar, click Fire Summary Working Set.
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The following diagram shows the Fire Summary for the Redfeather weath
station, “050505.”

Based on the Fire Summary graph, 1988 and 1989 have significant burn
acres and are therefore selected at the “Years to Remember” for the pock
card.

Generating the pocket card
After completing the background analysis you can generate a meaningfu
pocket card to highlight local conditions.

To generate a pocket card

1 On the FireFamily Plus toolbar, click Pocket Card.

2 Type or select Fire Danger Rating Area, Fire Danger Index, and Years 
to Remember.

If your working set does not include the current year, but there is current 
year data in the database, you can select the Year to Date check box to 
enable a third overlay.

If you have a bitmap graphic that shows the area location, click Browse to 
locate the file.

3 To select a fire for comparison, click Search in the appropriate Fires list, 
and then double-click the fire of your choice on the Select a Fire listing.

You can select up to three fires for comparison, but they must have 
occurred during the Years to Remember.

4 Type or select the Area Locator Bullets and Local Thresholds.
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5 Type Past Experience Text.  Include information specific to this area as 
well as any general and key points to remember.

6 When finished, click OK .

The following diagram shows a sample Generate Pocket Card screen.

The following diagram shows the “Grace Creek” fire selected on the Sele
Fire listing.
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The following diagram shows the generated pocket card.

To print a pocket card

1 On the File menu, click Print .

2 In the Name list, click the color printer of your choice.

3 To change the page orientation, click Properties, click Landscape, and 
then click OK .

To change the background pattern of your pocket card graphs

This option allows you to change the visual appearance of your graph.  L
carefully at the readability of the lines in your graph and what these 
background colors denote.  For example, don’t use red to denote the low
portion of your graph where the index value is low or moderate.  

FireFamily Plus will invert the colors for humidity and fuel moisture graphs 
where low is a higher fire danger.

1 On the Generate Pocket Card screen, click Graph Background.

2 Change the Vertical Percent fields as desired, and then click OK .
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The following Set Graph Background shows the background settings 
were used to create the sample pocket card.

To save a pocket card

You can save the pocket card in bitmap, GIF, JPEG, and TIFF.  Select the file 
format that suits your needs.

1 On the File menu, click Save As.

2 In the File name text box, type the file name of your choice, select the fi
format of your choice, and then click OK .
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Chapter 6.  Working with fire danger projections

This chapter explains how to generate medium range fire danger projecti
based on current year-to-date weather.  It also outlines several technique
developing fire weather scenarios.  

You can create projected observations using one the following:

• blank fire weather observations

• persistence of the last year-to-date fire weather observation in the 
working set

• fire weather observations generated from climatological percentiles fr
your active working set, which includes stations, years, and annual fil

To successfully create projected observations, you must have year-to-date 
observations in your active working set for the stations of interest.  The 
current year must be part of your active working set.  You can edit your 
projected observations, although these are not saved as part of your 
database.

Topics in this chapter include:

• Understanding generated fire weather records
• Reviewing the active working set
• Generating fire danger projections
• Generating reports and graphs.

Understanding generated fire weather records from 
climatological percentiles

Generated fire weather records use historical, individual daily percentiles of 
temperature, humidity, and wind speed.  This differs from the percentile for 
the entire working set.  For example, if your period length is one day ther
one observation for each year in the working set.  Therefore, a working set 
that contains 20 years of data contains 20 observations for each day from
which to select the percentile.  As compared to the overall critical percentile, 
this value is the same as plotting the seasonal values of critical percentiles on 
a statistical graph.

To generate projected observations from the 60th percentile of temperature for 
July 1 to July 15, FireFamily Plus examines the working set for the 60th 
percentile for the observed dry bulb, maximum and minimum temperature
for each of the 15 days.  By selecting the 10th percentile of humidity, 
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FireFamily Plus examines the working set for the driest 10th percentile of 
observed, maximum, and minimum relative humidities for each day.  
Similarly, by selecting 50th percentile winds, FireFamily Plus will calculate 
the median value of wind for each of those 15 days.  

You can project hot dry conditions by selecting high percentile values for 
temperature and low percentile values for humidity.

Projected observations from percentile weather have precipitation amoun
duration, and state of the weather initialized to “no precipitation” and “mos
sunny skies,” where state of the weather equals “1.”  It is up to you to cre
precipitation events, if desired, for your medium range projections.

Reviewing the active working set
The following diagram shows the active working set used for the example
this chapter.  Notice that observation data for the current year 2000 is 
available and selected in the working set.  Since there are no observation
year 2000 during the projections period, the projected observations you 
generate from historical percentiles will be based on daily observation da
from 1990 through 1999.  The analysis period length is one day.

You can project fire danger indexes for other analysis period lengths and for 
Special Interest Groups.
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Generating fire danger projections
This section explains how to generate NFDRS indexes from your projecte
observations. You can also generate projections from climatology and ob
the percentile values for temperature, humidity, and wind.

To start the fire danger projection module

• On the FireFamily Plus toolbar, click Fire Danger Projections.
Just as when you generate a statistical table or graph, FireFamily Plus 
automatically synchronizes your active working set when you click Fire 
Danger Projections.

The following diagram shows the Fire Danger Projections dialog box.  No
the starting date in this example is June 15th, 2000, which tells you that y
active working set has data for Plains through the 14th of June, 2000.

To select the fire danger projection options

1 Click Options >>>.

2 Based on the indexes you selected for your projection, select the Output 
Columns of your choice.

3 Modify the Graph Options as desired.

Graph Options allows you to distinguish the format of the projection line 
from the year-to-date and other overlays on the statistical season graph.  
You can also modify the projection line once you create the statistical 
season graph by clicking the Fire Danger Projections tab on the Graph 
Options dialog box.
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The following diagram shows the Projection options dialog box.  

The New Day WX Values option allows you to select the method for crea
the observations, either “Same as Previous Day,” “Blank,” or “Use Histori
Daily Percentiles.”  Although you can select only one New Day WX Value
option at a time, you can create several days of persistence, and then sw
a climatology sequence before clicking the Calculate button.

In this example, you will generate the following projections:

• temperature based on the 60th percentile, which is slightly above the
median

• humidity at the 40th percentile, which is slightly below the median

• wind speed based on the 75th percentile.

For this example, if you selected the Same as Previous Day option, every new 
record would be the same as June 14th, 2000.

To add days of projected weather data

• Click Add Day for each day of projected weather data.
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The following diagram shows the Fire Danger Projections beginning June
2000.  Notice that the daily observations vary slightly, there is no 
precipitation,  and the State-of-the-Weather (SOW) are all set to “1.”

You can add days up to the end of the Annual Filter as defined in your working 
set.

State of the Weather codes include:

0 clear (0.0 - 0.1) 5 drizzling
1 scattered clouds (0.2 - 0.5) 6 raining
2 broken clouds (0.6 - 0.9) 7 snow/sleet
3 overcast (100% obscured) 8 showering
4 foggy 9 thunderstorms in progress.

To remove a record from your list of Fire Danger Projections

• Highlight the record of your choice and then click Remove Day.

To modify the weather for a specific date

1 Highlight the record of your choice, and then modify the appropriate 
fields as desired.

2 When satisfied with your projection strings, click Calculate.
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The following diagram shows cloudiness (SOW=2) for June 16th through
18th, and three hours of rain (0.05 inches) for June 21st.

The following diagram shows the calculated outputs for your fire danger 
projections.  

From here, you can change, delete, or add the projected observations and 
recalculate as desired.  You can also change the projections options.
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Generating reports and graphs
This section explains how to generate reports and graphs from your 
projections.

To generate reports and graphs from your projections

1 Click Reports & Graphs.

2 In the Available column, highlight the variable of your choice, and then
click >>>> to move that variable to the Selected column.  To generate a 
graph for every available variable, click Select All.

3 To generate a text file of the projected weather and indexes, click 
Generate Report.

4 To generate the reports and graphs, click OK .

The following diagram shows the Select Outputs to Generate dialog box.
After generating the reports and graphs, you can return to the Fire Dange
Projections dialog box and edit your projection strings.

If you select the Close Forecast Window check box, FireFamily Plus will end 
your current projection session and return to your active working set after you 
generate the reports and graphs. To continue to edit your projection strings 
without starting all over again, be sure to clear this check box.
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The following diagram shows the Fire Danger Projections window as it fir
appears after clicking OK.  FireFamily Plus reprocesses the working set t
obtain any potential overlay years and then displays a window for each g
object you selected.  These windows appear behind the Fire Danger 
Projections window. 

The following diagram shows the ERC graph window.  Here, the heavy 
dashed line represents the projected ERCs based on your generated proj
strings.
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To create an overlay on your statistical projections graph

1 On the Options menu, click Overlays.

2 Click New, then select the Year, Line Style, and Color for the overlay.

3 To review the appearance of the overlay, click Apply.

4 When finished adding new overlays, click OK .
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Chapter 7.  Performing hourly data analysis

This chapter explains how to work with hourly weather data.  Topics inclu

• Generating hourly listings
• Generating diurnal graphs
• Exporting hourly weather data to FarSite
• Viewing hourly observations.

You can only import files from NIFMID that are in the standard FW9 forma
The FW9 file format has several observation types, including:

• O type.  A 1300 hour NFDRS record with State of the Weather.

• R type.  An hourly weather observation record without State of the 
Weather.

If a station in your active working set contains “R” type observations, you w
be able to choose from the Hourly Data Analysis options on the Weather 
menu.  If no stations contain “R” type observations, these options appear
dimmed.

FireFamily Plus version 2.0 does not import hourly RAWS data archived at the 
Western Region Climate Center due to the following:

• the data is not available on the web

• the data is not in standard format

• the NFDRS station id is not associated with the weather observations, 
and is tracked by NESDIS ID.

A future release of FireFamily Plus will accommodate this type of data and 
improve its diurnal graphing and data analysis capabilities.
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Generating hourly listings
Like everywhere else in FireFamily Plus, your hourly data analysis resultsare 
controlled by how you configure your active working set.  

To generate an hourly listing

1 On the Weather menu, point to Hourly Data Analysis, then click 
Hourly Listings .

2 Select the General formatting, Data Format, and Time Format options 
of your choice.

3 In the Available Variables column, highlight the variable of your choice
and then click >>>> to move that variable to the Selected Variables 
column.  To generate an hourly listing for every available variable, clic
Select All.

4 To generate the hourly listing, click OK .

The following diagram shows the Select Output Variables for Hourly Listin
dialog box.

To change the order of your Selected Variables, highlight the Selected 
Variable of your choice and then click the up and down arrows to move it up or 
down.
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The following diagram shows the resulting hourly listing for Dry Bulb 
Temperature, Relative Humidity, and Wind Speed.

Generating diurnal graphs
The Diurnal Graphs option allows you to determine the hourly average va
for all days in your active working set.  It also allows you to generate a 
companion report of the average value for each hour for each day of the 
not for each day of each year.  

Each variable you select will produce one graph.  FireFamily Plus version 2.0 
does not support multiple variables on a single graph.

There are no overlays or graphic configuration options for diurnal graphs.

The following diagram shows the active working set used for the example
this chapter.
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To generate an diurnal graph

1 On the Weather menu, point to Hourly Data Analysis, then click 
Diurnal Graphs .

2 In the Available Variables column, highlight the variable of your choice
and then click >>>> to move that variable to the Selected Variables 
column.  To generate diurnal graphs for every available variable, click
Select All.

3 To generate the diurnal graphs, click OK .

The following diagram shows the Generate Diurnal Graphs dialog box.

The following diagram shows the resulting Wind Speed Diurnal Analysis 
graphs.

The report on the left displays the average value for each day in the work
set.  For example, on May 1st the average 0300 wind speed is 3 miles/hou
the years 1995 through 2000.
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The graph on the right displays the “0000” through “2300” hourly average
for all days in the working set, which is essentially the average of each 
column in the report.  For the years 1995 through 2000 for all days, May 
through June 21st, the 0300 mean wind speed is about 2 miles/hour and
to about 4 miles/hour at 1300.

The graph may not always display the precise average of each column in the 
report. The report does not display the number of observations for each day/
hour, which may vary from cell to cell. 

The following diagram shows the resulting mode wind direction graph.  
Instead of a numerical average, the mode direction identifies the most often 
occurring direction.

Wind directions are classified to the eight standard wind directions in a fir
weather observation, where 0 = Calm, 1 = NE, 2 = E and so on.  In this 
example, the daytime prevailing wind direction is from the West or 
Southwest, while the night prevailing wind direction has an easterly 
component with a few hours of calm between 0600 and 0800.

Remember, this summary is based on your active working set.

To save your diurnal reports and graphs

1 On the File menu, point to Save, and then click Report or Graph.

2 Type a name of your choice and then click Save.  Reports are saved using
the .txt file extension.  Graphs can be saved in a variety of file formats
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Exporting hourly weather data to FarSite
The FarSite Exports option allows you to automatically create FarSite export 
files from your active working set, one file for each day.  These files are 
compatible to FarSite version 3 and version 4, which is due for release in
fall of 2000.

Generally, select a period from a specific year from your climatology analysis 
period of weather for your Farsite simulations.  

To create a FarSite export file

1 On the Weather menu, point to Hourly Data Analysis, then click 
FarSite Exports.

2 Select the FarSite File Types check boxes of your choice, click >>>> to 
browse the folder location of your choice, and then type the File Name of 
each export file.

The following diagram shows the Generate FarSite Data Files dialog box

You can save these export files in any folder you choose. 
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The following diagram shows the layout of the export weather file for FarS
version 3.  This weather file has one summary record per day.  The fields
month, day, precipitation amount, time of minimum temperature, time of 
maximum temperature, minimum temperature, maximum temperature, 
maximum relative humidity, minimum relative humidity, and station 
elevation.

The following diagram shows the wind export file.  It contains an hourly 
listing for each day in the working set range and identifies month, day, ho
minute, wind speed, direction (azimuth), and cloud cover.  

Cloud cover is “0” unless rain occurred during the hour.  If rain occurred, it is 
set to “100.”  In this example, no rain occurred.
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Viewing hourly observations
The View Observations option on the Weather menu allows you to view ei
daily observations (1300 NFDRS type “O” observations) or all observatio
in your active working set.

To view all observations in your working set

• On the Weather menu, point to View Observations, and then click All .

The following diagram shows all observations in your working set.  Notice
the buttons available on the toolbar.

To save (export) observation records to your personal computer

• Click Export Data, select the file format of your choice, and the save t
file in a folder of your choice.
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The following diagram shows the Export Weather Data to a Text File dialo
box.  From here, you can export weather data and save it in a variety of 
formats.

To delete a range of observations from your active working set

1 Select the record of your choice, and then click Delete Records.

2 In the Start Record box, type or select the first record of your choice.

3 In the End Record box, type or select the last record of your choice, an
then click OK .

4 To confirm the delete, click OK .

The following diagram shows the Enter Range of Records to Delete dialo
box.
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The following diagram shows the warning message for deleting weather 
observations from your active working set.

To sort the weather observations

• Right-click on the column of your choice, and then select either 
Sort Ascending or Sort Descending.

The following diagram shows the View Weather Data listing as it appears
when you right-click on the ObsDate column.

To increase a column width

• Position the pointer in the column heading of your choice, and then d
to the right or to the left to increase or decrease the column width.

You can also increase or decrease the height of any row using this same 
method.
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To print the weather observations in your working set

• Click Print Table, select the Options and Available fields of your 
choice, and then click OK .

The following diagram shows the Select Fields to Print dialog box.

Since you are dealing with hourly data, printing these files may require vast 
quantities of paper!  Be sure that is what you want to do!
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Appendix A.  Retrieving NIFMID data using KCFAST

This chapter explains how to use the Kansas City Fire Access Software 
(KCFAST) to download information into FireFamily Plus.  KCFAST allows 
you to extract weather and fire occurrence data and station catalog 
information from the National Interagency Fire Management Integrated 
Database (NIFMID).  Topics include:

• Accessing KCFAST
• Retrieving weather, fire occurrence, and station catalog data
• Downloading files from the ftp site to your personal computer.

Accessing KCFAST
KCFAST is available on the Fire and Aviation Management web page

http://famweb.usda.gov.  

You must have a valid WIMS/NIFMID logon ID and password to retrieve data 
from NIFMID.  For more information, send your request to fire?@fs.fed.us.

To access KCFAST from the Internet

1 Start your Internet browser. 

2 In the address box, type http://famweb.usda.gov then press ENTER.

3 Click KCFAST.

After accessing this web page, you can save time later by adding this address 
to your browser as a bookmark.
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To setup your WIMS/NIFMID logon ID for KCFAST retrievals

1 From the KCFAST Main Menu, click Setup.

2 Type your Username and Password, and then click OK.

Your Username is in the format:

ops$[WIMS/NIFMID logon id]

For example, “ops$fs1234” is a valid Username.

3 Type your Email address, and then click Submit.

The following User Profile Information screen shows a sample Email 
address.

Retrieving weather, fire occurrence, and station 
catalog data

There are three basic types of data that you can retrieve from NIFMID:

• Historical fire weather data identifies data collected from specific weather 
stations.

• Fire occurrence data identifies data collected from the U.S. Forest 
Service.

• Station catalogs identify key weather station information.

Be sure to select “Send file to ftp site” when retrieving weather data from 
KCFAST.  Currently, FireFamily Plus does not reliably import raw file 
occurrence files retrieved with a browser.
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To retrieve historical fire weather data

Although historical fire weather data is either saved in “72” format or “98” 
format, you will request most of your retrievals in the “72” format.  For more 
information about these formats, see Appendix A, “WIMS file formats.”

1 From the KCFAST Main Menu, click Weather.

2 Click Data Extract, and then click Historical.

3 Type the Station ID,  and then Begin and End Date Range.

4 Click Raw Datafile - 1972 Data Format.

5 Select the email notification option of your choice, and then click 
Submit.

The following Historical Fire Weather Data Extract screen shows a 
retrieval for station 101221 and spanning the month of July, 1995.

The following  screen shows a sample FTP REQUEST CONFIRMATION 
message for station ID “050505.”

6 Write down the file name so that you can locate this file when you access 
the site ftp.fs.fed.us.
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To retrieve U.S. Forest Service fire occurrence data

1 From the KCFAST Main Menu, click Fire.

2 Click Standard Extract.

3 Type the two digit Region and two digit Forest numbers.

4 Type the Begin Year and End Year Date Range.

5 Click NFMAS - PCHA (PC Historical Analysis).

6 Click Raw Datafile.

For more information about RAW and FPL data layouts, click Datafile 
Definition.

7 Select the email notification option of your choice, and then click 
Submit.

The following Fire Occurrence Data Extraction screen shows a retrieval 
for Region 02, Forest 10 and spanning the years 1975 through 1999.

The following  screen shows a FTP REQUEST CONFIRMATION 
message.
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8 Write down the file name so that you can locate this file when you access 
the site ftp.fs.fed.us.

To retrieve station catalog information for a single station

1 From the KCFAST Main Menu, click Weather.

2 Click Station Catalog, and then click Station Information.

3 Click BY SINGLE STATION, and then type the desired Station ID.

4 Click Send file to FTP site.

5 Select the email notification option of your choice, and then click 
Submit.

The following Weather Station Information screen shows a station 
information retrieval for station “050505.”

6 Write down the file name so that you can locate this file when you access 
the site ftp.fs.fed.us.
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Downloading files from the ftp site to your personal 
computer

In KCFAST, retrievals are named so that you can easily identify each file and 
its contents.  For example, you can identify a KCFAST weather observation 
retrieval as follows:

If you choose, you can rename KCFAST retrievals when you download the 
file.  Use the following list as a guideline:

For record layouts of RAW and FPL files, follow the procedure outlined on 
page 2.4, “To retrieve U.S. Forest Service fire occurrence data.”  For step 6, 
click Datafile Definition.

Before downloading fire weather, fire occurrence, and station catalog files, 
you can better organize your retrievals by storing them in separate folders.  
For example, to store weather observation files, create the folder “fsapps/fam/
FireFamily Plus/FWX files.” To store fire occurrence files, create the folder 
“fsapps/fam/FireFamily Plus/RAW files.”  To store a working set database, 
create the folder “fsapps/fam/FireFamily Plus/MDB files.”

To download a file from ftp.fs.fed.us

1 Start your Internet browser. 

2 In the address box, type ftp://ftp.fs.fed.us/incoming/wo_fam then press 
ENTER.

3 Right-click the file name of your choice, click Copy to folder, then 
double-click the folder of your choice.

• [forestname].fpl for fire occurrence files at the forest level, minus the 
fire name

• wx[stationID].fwx for weather observation files in the 72 format

• wx[stationID].fw9 for weather observation files in the 98 format
• [forestname].raw for fire occurrence files at the district level, including 

fire name, in the full FS5100-29 report format
• [name].txt for text files to be imported into FireFamily Plus.
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Appendix B.  Using FireFamily Plus with RERAP

The Percentile Weather report allows you to select a variable and select a
wind direction for preparing a Rare Event Risk Assessment Program 
(RERAP) report.

For example, given an ignition in an area approved for wildland fire use for 
resource benefits, you can use historical weather records, fuels, and weather 
conditions to calculate the probability of the fire being pushed to a particular 
point of concern.

To generate a Percentile Weather report

1 On the Weather menu, click Season Reports, and then click Percentile 
Weather.

2 In the Analysis Variable list, select the desired variable, and then click
OK .

3 Click the desired Wind Direction(s) that would head the fire toward the 
point of concern.

4 To calculate fuel moisture and wind speeds associated with the ERC 
values, click Calculate (1).

5 To calculate an ERC and SC from the fuel moisture and wind speed 
values, click Calculate (2).

6 To obtain a table and a printable report, click Done (3).
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The following diagram shows Energy Release Component selected a
percentile weather analysis variable.

The resulting diagram combines many RERAP calculations into one scre
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The following diagram shows the Percentile Weather for RERAP report.

For more information about RERAP, refer to “RERAP-Rare Event Risk 
Assessment Process User’s Guide.”
B.3 July 1, 2000



ncy.  
hy.  

en 

 
ust 
Appendix C.  Importing data from other agencies

This appendix explains how to create and save a custom agency within the 
active database and then import fire occurrence data from that custom age
Like the agency definitions, you can define a one, two, or three tier hierarc
Topics include:

• Defining a custom agency
• Importing data from your custom agency.

Defining a custom agency
A custom agency allows you to associate fires with a SIG or station.  Wh
you create a custom agency, you must know the following:

• the name of the units
• the codes of the units as found in the import files.

The following diagram shows the tree-like structure of an agency. 

If your import files do not contain codes for regions, units, or subunits, assign 
a “dummy code” that allows you to select the region, unit, and/or subunit as 
the default for the entire file.

This section explains how to create a two-tier custom agency, including a
region and unit.  You must define a region as the first tier.  However, you m
only define unit and subunit tiers if these are required for your agency.
July 1, 2000 C.1



FireFamily Plus User’s Guide Appendix C. Importing data from other agencies

it/
To create a custom agency

1 On the Data menu, click Agencies.

2 Click New, type the new agency name in the Agency Name box, and then 
click OK .

The following diagram shows the new agency name, “Nature Cons.” 

The following diagram shows the new agency displayed on the Create/Ed
Delete Agencies dialog box.

To define a region for your custom agency

1 Click the custom agency of your choice, and then click Regions.

2 Type the Code and Name of the region and then click OK .

The following diagram shows the Edit Region dialog box.
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The following diagram shows the new SouthWest District 1 region.

To define a unit for your custom agency

1 Click the region of your choice, and then click Units.

2 Type the Code and Name of the unit and then click OK .

The following diagram shows the Edit Units dialog box.

The following diagram shows the new Shreveport Highlands unit. 
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To define a subunit for your custom agency

1 Click the unit of your choice, and then click Subunits.

2 Type the Code and Name of the subunit and then click OK .

Subunits are created in the same manner as regions and units.  The example 
in this appendix does not have any subunits defined for the custom agency.

To review the new custom agency structure

1 On the Fires menu, click Associations.

2 Click the custom agency tab of your choice.

The following diagram shows the new custom agency and hierarchy.

Importing data from your custom agency
This section explains how to define the import file format for your custom
agency.  Before you can define the import file format, you must first revie
the record layout of the data.

You may want to print out a copy of the import file, then use a ruler to delimit 
the columns.

To define the import file format for your custom agency

1 Review the record layout of the import file and determine the column 
number of the following fields

Region Fire Number
Unit Acres
Subunit, if any Cause
Year, Month, and Day Fire Name.

2 On the Data menu, click Import .
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s.
3 Select the Agency of your choice, then click Fpl Files.

Unless importing USFS files, which can be in either “fpl” or “raw” format, 
you can only select the Fpl Files button as the import file type.

4 On the Define Import File Format dialog box, click the Duplicate 
Checking option of your choice.

5 Using the record layout from step 1, complete the Record Layout boxes.

Type 0 (zero) for any field not defined in the import file.

6 When finished defining the record layout, click OK , then Open the 
import file of your choice.

The following diagram shows the record layout and sample records for the 
file “NARTC2.fpl.”

The following diagram shows the drop-down list box of available agencie
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The following diagram shows the Define Import File Format dialog box.
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Appendix D.  Adding missing subunits

This appendix explains how to add missing subunits to your FireFamily P
template database.  Once you complete this task, every subsequent data
that you create will display these subunits.

Using a generic region/unit/subunit internal structure, FireFamily Plus ble
fire data based on the different organizational structures of each agency. 
Since many Forest Service Districts have been consolidated over the yea
that is systematically impossible to track, you may find that you need to a
missing subunits to your FireFamily Plus template database.

The tasks in this appendix explain how to use Microsoft Access 2000® to edit 
a FireFamily Plus template database previously created in Microsoft Access 

97®.  Exit FireFamily Plus before proceeding.

To open the template database

1 On the Start menu, point to Programs, and then click Access.

2 On the Microsoft Access dialog box, click Open an existing file, and 
then double-click More Files.

3 Open the FireFamily Plus folder.

This folder is usually located in the “c:/fsapps/fam” folder.

4 In the Files of type box, select All Files, and then double-click 
fireplus.ffp .

5 In the Convert/Open Database dialog box, click Open Database, and 
then click OK .

6 Double-click FireSubunits.

The following diagram shows the Microsoft Access dialog box.
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The following diagram shows the location of the template database 
“fireplus.ffp.”

The following diagram shows the MS Access 2000 Convert/Open Databa
dialog box.

This dialog box does not display if you use MS Access 97 to update your 
template database.

The following diagram shows the “FireSubunits” table selected.
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To add a subunit to the FireSubunits table - an example

This task explains how to add the missing subunit “38,” district “07 Woodsey 
RD” to the last row “642” on the FireSubunits table.

1 Scroll down until you display the appropriate districts for your area, th
review the FireSubunits table and determine if there are any missing 
subunits.  Write down the Unit ID that pertains to any missing subunit

2 Scroll down to the last entry in the FireSubunits table.

3 In the * (asterisk) row, click in the SubunitID  column, and then type the 
next sequential number in the table.  

Watch for zeroes (0) that may be inadvertently inserted in the table!  For 
example, be sure to type “642,” not “6420.”

4 In the UnitID  column, type the unit identifier.

5 In the Name column, type the name of the missing subunit.

6 To save and exit the FireSubunits table, click Exit  on the File menu.

The following diagram shows the FireSubunits table.  Notice the missing 
subunit on the Boise National Forest.
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The following diagram shows the new subunit added to the end of the 
FireSubunits table.

This example shows you how to change the template database.  To import 
new fire occurrence data, you must create a new database from the modified 
template database.

You can also modify an existing working database in the same manner, but 
you must re-import the fire occurrence data again to update the fires in the 
existing database.  More than likely, these fires were rejected during the 
previous import process due to invalid subunits.
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Glossary of fire terms

A
ambient.  Surrounding, enveloping conditions.  As it pertains 
to weather at the earth’s surface, the conditions measured in 
the instrument shelter are considered ambient.

annual.  A plant that lives for one growing season, starting 
from a seed each year.

aspect.  Represents the aspect at the weather station site. 
Used in NFDRS calculations.  Valid values are 1 - 8:

1 - N 5 - S
2 - NE 6 - SW
3 - E 7 - W
4 - SE 8 - NW

average precipitaiton.  The historic average annual 
precipitation for the weather station.  Used in NFDRS 
calculations.

average relative humidity.  The arithmetic average of the 
maximum and minimum relative humidities measured at a 
fire-danger station from one basic observation time to the next.

B, C
base fuel model.  The fuel model that best represents the 
fuels on the base area.

basic observation time.  The time established to take the 
fire-dander observation.  It should be at that time of day when 
the fire danger is normally the highest.

boundary conditions.  The EMC commensurate with the 
temperature, relative humidity, and precipitation events of the 
preceding 24 hours.

brush.  Scrub vegetation and stands of tree species that do not 
produce merchantable timber.  Not a synonym for slash.

Burning Index (BI).  A number related to the contribution of 
fire behavior to the effort of containing a fire.

climate class.  Defines the drying and wetting rates for 
annuals, perennials, and woody plants.

D

dead fuels.  Naturally occurring fuels whose moisture 
content is governed by relative humidity and precipitation.

deciduous.  When checked, this flag signifies that trees at 
the weather station site are primarily deciduous.  When 
unchecked, this flag signifies primarily coniferous trees at the 
weather station site.  Used in NFDRS calculations.

dew point.  The temperature at which a parcel of air being 
cooled reaches saturation (100 percent relative humidity).

diurnal.  Pertains to daily cycles of temperature, relative 
humidity, and wind.

drought.  A period characterized by a serious moisture 
deficiency, extensive in area and time.

dry bulb temperature.  The temperature of the air.

duff.  The partially decomposed organic material of the forest 
floor that lies beneath the freshly fallen twigs, needles, and 
leaves.

E
elevation.  The elevation, in feet, of the weather station.  
Used in NFDRS calculations. 

Energy Release Component (ERC).  A number related to 
the available energy (Btu) per unit area (square foot) within the 
flaming front at the head of a fire.

Equilibrium Moisture Content (EMC).  The moisture 
content that a fuel particle will attain if exposed for an infinite 
period in an environment of specified constant temperature 
and humidity.  When a fuel particle has reached its EMC, the 
net exchange of moisture between it and its environment is 
zero.

escaped fire.  A fire that has exceeded or is anticipated to 
exceed preplanned initial action capabilities, fire management 
direction, or selected appropriate suppression response.

extinction moisture content.  The fuel moisture content, 
weighted over all the fuel classes, at which the fire will not 
spread.
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F
fine fuels.  The complex of living and dead herbaceous plants 
and dead woody plant materials less than one-fourth inch in 
diameter.

Fine Fuel Moisture (FFM).  An adjustment to the 1-h TL 
FM that compensates for the presence of living plant material 
and the moisture content of that material.  The FFM is used in 
the manual calculation of fire-danger ratings.  It replaces the 1-
h TL FM and the herbaceous fuel moisture.

firebrand.  Any source of heat, natural or human-made, that 
is capable of igniting natural fuels.

fire-danger rating area.  A geographical area within which 
the fire danger can be assumed to be uniform.  It is relatively 
homogenous in climate, fuels, and topography.

fireline intensity.  The rate of heat release per unit length of 
fire front.  The most commonly used units in current fire 
literature are Btu/sec/ft.

fire management direction.  Fire management standards, 
guidelines, and practices based upon land and resource 
management objectives.  Fire management direction defines 
the kind, level, and timing of fire protection and use activities, 
including the appropriate suppression strategies that efficiently 
meet management objectives for each management area for the 
range of expected fire behavior conditions.

flaming front.  That zone of a moving fire where the 
combustion is primarily flaming.  Behind the flaming front the 
combustion is primarily glowing or involves the burning out of 
larger fuels (greater than about three inches in diameter.)

FM1 = FM10.  When checked, this flag signifies that the 1-
hour fuel moisture is equal to the 10-hour fuel moisture.  Used 
in NFDRS calculations.

forecast area.  The geographical area for which a fire 
weather forecast is specified.

freeze day of year.  The day of the year (1 to 365) 
considered to be the historic average day for the first killing 
frost.  Used in NFDRS calculations.

fuel class.  A group of fuels possessing common 
characteristics.  In NFDRS, dead fuels are grouped according 
to their timelag (1-, 10-, 100-, and 1000-hr TL).  Living fuels 
are grouped by whether they are herbaceous (annual or 
perennial) or woody.

fuel model.  A simulated fuel complex for which all the fuel 
descriptors required by the mathematical fire spread model 
have been specified.

fuel moisture analog.  A device that emulates the moisture 
response of specific classes of dead fuels.  Examples are 
basswood slats that represent the 1-h TL fuels and half-inch 
ponderosa pine dowels that represent the 10-h TL fuels.  An 
analog may also be constructed of inorganic materials.

Fuel Moisture Content (also Fuel Moisture) (FM).  The 
water content of a fuel particle expressed as a percent of the 
ovendry weight of the fuel particle.

fuel proportion.  That length of the traverse distance on a 
segment, divided by the total length of the assessment line.

G, H
greenup.  The beginning of a new cycle of plant growth.  The 
greenup date may occur at different dates for different fuel 
models.

herb.  A plant that does not develop woody, persistent tissue 
but is relatively soft or succulent and sprouts from the base 
(perennials) or develops from seed (annuals) each year.  
Included are grasses, forbs, and ferns.

herbaceous fuels.  Undecomposed material, living or dead, 
derived from herbaceous plants.

herbaceous vegetation moisture content.  The water 
content of a live herbaceous plant expressed as a percent of the 
ovendry weight of the plant.

holdover fires (also sleeper fires).  Fires set by lightning 
but not discovered during the first burning period.  In the 
NFDRS it is assumed that 25 percent of the fires are not 
discovered until succeeding burning periods.

Human-caused Fire Occurrence Index (HCOI).  A 
value derived from the Human-caused Risk (HCR) sources in 
a rating area and the Ignition Component (IC).  HCOI is 
interpretable in terms of expected numbers of fires on the 
rating area.

Human-Caused Risk (HCR).  A number related to the 
expected number of human-produced firebrands capable of 
starting fires that a rating area will be exposed to during the 
rating period.

human-caused risk scaling factor.  A number relating 
human-caused fire incidence to the Ignition Component (IC) 
on a rating area.  The factor is a statistic based on three to five 
years of fire occurrence and fire weather data that adjusts the 
prediction of the basic human-caused fire occurrence model to 
fit local experience.

humidity.  A measure of the water-vapor content of the air.
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I
Ignition Component (IC).  A rating of the probability that a 
firebrand will cause a fire requiring suppression action.

initial action.  The prompt, preplanned response to a 
wildfire.

initiating fire.  A fire that has recently started and is not 
crowning or spotting.

insolation.  Solar radiation received at the earth’s surface.

instrument shelter (also thermoscreen).  A naturally or 
artificially ventilated structure used to shield temperature-
measuring instruments from direct sunshine and precipitation.

K, L
KCFAST, KCFAST/PC.  A menu-based computer 
application that automatically builds and submits customized 
jobs from your personal computer to the IBM mainframe 
computer at the USDA National Information Technology 
Center in Kansas City.

lesser live fuels.  Grasses and forbs; low nonwoody plants, 
annual and perennial.

Lightning Activity Level (LAL).  A numerical rating of 
one to six, keyed to the start of thunderstorms and the 
frequency and character of cloud-to-ground lightning, 
forecasted or observed on a rating area during the rating 
period.

Lightning Fire Occurrence Index (LOI).  A numerical 
rating of the potential occurrence of lightning-caused fires.

Lightning Risk (LR).  A number related to the expected 
number of cloud-to-ground lightning discharges capable of 
staring fires that a rating area will be exposed to during the 
rating period.

lightning risk scaling factor.  A factor derived from local 
thunderstorm and lightning-caused fire records that adjusts the 
predictions of the basic lightning fire occurrence model to 
local experience.  It accounts for factors not addressed directly 
by the model such as susceptibility of local fuels to ignition by 
lightning, fuel continuity, topography, and regional 
characteristics of thunderstorms.

litter.  The top layer of the forest floor, typically composed of 
loose debris such as branches, twigs, and recently fallen leaves 
or needles; little altered in structure by decomposition.

live fuels.  Naturally occurring fuels whose moisture content 
is controlled by physiological processes within the living 
plant.  The NFDRS considers only herbaceous plants and 
woody plant material small enough (leaves and needles, and 
twigs) to be consumed in the flaming front of a fire.

M
mobilization.  Documented procedures in the National 
Interagency Mobilization Guide that defines two categories for 
equipment and supplies.  E (equipment) requests include 
major firefighting items such as rolling stock, radios, 
telecommunications equipment, national caterers, national 
showers, cache vans ATMUs, and speciality items.  S (supply) 
requests include most NFES cache items.

N, O
National Fire Danger Rating System (NFDRS).  A 
uniform fire-danger rating system that focuses on the 
environmental factors that control the moisture content of 
fuels.

1-hour timelag fuels.  Fuels consisting of dead herbaceous 
plants and roundwood less than one-fourth inch in diameter.  
Also included is the uppermost layer of litter on the forest 
floor.

1-hour Timelag Fuel Moisture.  The moisture content of 
the 1-hour timelag fuels.

100-hour timelag fuels.  Dead fuels consisting of 
roundwood one to three inches in diameter, and, very roughly, 
the forest floor from three-fourths inch to four inches below 
the surface.

100-hour Timelag Fuel Moisture.  The moisture content 
of the 100-hour timelag fuels.

1000-hour timelag fuels.  Dead fuels consisting of 
roundwood three to eight inches in diameter or the layer of the 
forest floor more than about four inches below the surface or 
both.

1000-hour Timelag Fuel Moisture.  The moisture content 
of the 1000-hour timelag fuels.

P
perennial.  A plant that lives for more than two growing 
seasons.  For fire-danger rating purposes, biennial plants are 
classed with perennials.
July 1, 2000 DRAFT iii



Glossary of fire terms FireFamily Plus User’s Guide
precipitation.  Any or all the forms of atmospheric water, 
liquid, or solid that reach the ground.  Usually measured to the 
nearest one-hundredth of an inch.

precipitation duration.  The time, in hours and fraction of 
hours, that a precipitation event lasts.  More precisely, for fire-
danger rating purposes, it is the length of time that fuels are 
subjected to liquid water during the day.

R
Relative Humidity.  The ratio of the actual amount of water 
vapor in the air to the amount necessary to saturate the air at 
that temperature and pressure.  It is expressed as a percentage.

Remote Automatic Weather System (RAWS).  A 
WIMS satellite station that automatically tracks and stores 
weather information.

residence time.  1.  The time required for the flaming zone 
of a fire to pass a stationary point.  2.  The width of the flaming 
zone divided by the rate of spread of the fire.

roundwood.  Boles, stems, or limbs of woody material; that 
portion of the dead wildland fuels that are roughly cylindrical 
in shape.

S
shrub.  A woody perennial plant differing from a perennial 
herb by its persistent and woody stem; and from a tree by its 
low stature and habitat of branching from the base.

slash.  Branches, bark, tops, cull logs, uprooted stumps, and 
broken or uprooted trees left on the ground after logging; also 
debris resulting from thinnings or wind.

slope.  Rise or fall (in feet) per 100 feet of horizontal 
measurement, expressed as a percentage.

Spread Component (SC).  A rating of the forward rate of 
spread of a head fire.

standard drying day.  A day producing the same net drying 
as a 24-hour period where the dry bulb temperature is 
maintained at 80° F and the relative humidity at 20 percent.

Staffing Index.  A code that identifies the fuel model and 
forms the basis for fire-danger rating decisions.

statistical wildfire.  A wildfire that burns uncontrolled in 
vegetative or associated flammable material and either 
requires suppression action to protect natural resources or 
values associated with natural resources, or is destructive to 
natural resources.

surface area-to-volume ratio.  The ratio of the area of the 
surface of a fuel particle (square feet) to its volume (cubic 
feet).  The higher the ratio, the finer the particle; for example, 
for grasses this ratio ranges above 2,000; for a half-inch fuel 
moisture stick it is 109.

T
10-hour timelag fuels.  Dead fuels consisting of 
roundwood one-fourth to one inch in diameter and, very 
roughly, the layer of litter extending from just below the 
surface to three-fourths inch below the surface.

10-hour Timelag Fuel Moisture.  The moisture content of 
the 10-hour timelag fuels.

U, V
unplanned ignition.  A fire started at random by either 
natural or human causes, or a deliberate incendiary fire.

volatiles.  Readily vaporized organic materials which, when 
mixed with oxygen, are easily ignited.

W
Weather Information Management System (WIMS).  A 
comprehensive system that manages fire-weather information.

wildfire.  An unwanted wildland fire not designated and 
managed as a prescribed fire and that requires appropriate 
suppression action.

windspeed.  Wind, in miles per hour, measured at 20 feet 
above the ground or the average height of the vegetative cover, 
and averaged over at least a ten minute period.
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The U.S. Department of Agriculture (USDA) prohibits discrimination in all its
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age, disability, political beliefs, sexual orientation, or marital or family status. (Not
all prohibited bases apply to all programs.) Persons with disabilities who require
alternative means for communication of program information (Braille, large print,
audiotape, etc.) should contact USDA’s TARGET Center at (202) 720-2600 (voice
and TDD).

To file a complaint of discrimination, write USDA, Director, Office of Civil Rights,
Room 326-W, Whitten Building, 1400 Independence Avenue, SW, Washington,
DC 20250-9410 or call (202) 720-5964 (voice or TDD). USDA is an equal
opportunity provider and employer.

The Rocky Mountain Research Station develops scientific information
and technology to improve management, protection, and use of the
forests and rangelands. Research is designed to meet the needs of
National Forest managers, Federal and State agencies, public and
private organizations, academic institutions, industry, and individuals.

Studies accelerate solutions to problems involving ecosystems,
range, forests, water, recreation, fire, resource inventory, land reclama-
tion, community sustainability, forest engineering technology, multiple
use economics, wildlife and fish habitat, and forest insects and dis-
eases. Studies are conducted cooperatively, and applications may be
found worldwide.

Research Locations

Flagstaff, Arizona Reno, Nevada
Fort Collins, Colorado* Albuquerque, New Mexico
Boise, Idaho Rapid City, South Dakota
Moscow, Idaho Logan, Utah
Bozeman, Montana Ogden, Utah
Missoula, Montana Provo, Utah
Lincoln, Nebraska Laramie, Wyoming

*Station Headquarters, Natural Resources Research Center,
2150 Centre Avenue, Building A, Fort Collins, CO 80526
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